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1 Introduction And Scope

Reflex is the ESO Recipe Flexible Execution Workbench, an environment to run ESO VLT pipelines which
employs a workflow engine (Kepler1) to provide a real-time visual representation of a data reduction cascade,
called a workflow, which can be easily understood by most astronomers. This document is a preliminary tutorial
designed to enable the user to employ the KMOS workflow to reduce his/her data in a user-friendly way.

A workflow accepts science and calibration data, as delivered to PIs in the form of PI-Packs (until October
2011) or downloaded from the archive using the CalSelector tool2 and organises them into DataSets, where
each DataSet contains one science object observation (possibly consisting of several science files) and all asso-
ciated raw and static calibrations required for a successful data reduction. The data organisation process is fully
automatic, which is a major time-saving feature provided by the software. The DataSets selected by the user for
reduction are fed through the workflow which executes the relevant pipeline recipes (or stages) in the correct
order. Full control of the various recipe parameters is available within the workflow, and the workflow deals
automatically with optional recipe inputs via built-in conditional branches. Additionally, the workflow stores
the reduced final data products in a logically organised directory structure and employing user-configurable
file names. This tutorial deals with the reduction of KMOS IFU observations only via the KMOS Reflex
workflow. The user is referred to the KMOS user manual (Cirasuolo 20133). More information on the instru-
ment itself as well as a summary of available documentation, recent news, and tools, can be found at the ESO
instrument web pages 4. A brief description of the KMOS data flow is given in Davies 20125)

The quick start section (see Section 4) describes the minimum effort to get started, and it makes up only two
pages of text in this tutorial. User support for this software is available by sending enquiries to usd-help@eso.org.

1https://kepler-project.org
2http://www.eso.org/sci/archive/calselectorInfo.html
3available at: http://www.eso.org/sci/facilities/paranal/instruments/kmos/doc
4http://www.eso.org/sci/facilities/develop/instruments/kmos.html
5available at: http://www.mpe.mpg.de/389507/davies-7735-254x.pdf
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2 Software Installation

The software pre-requisites for Reflex 2.4 may be found at:
http://www.eso.org/sci/software/pipelines/reflex_workflows/.

To install the Reflex 2.4 software and demo data, please follow these instructions:

1. From any directory, download the installation script:

wget ftp://ftp.eso.org/pub/dfs/reflex/install_reflex

2. Make the installation script executable:

chmod u+x install_reflex

3. Execute the installation script:

./install_reflex

and the script will ask you to specify three directories: the download directory <download_dir>, the
software installation directory <install_dir>, and the directory to be used to store the demo data
<data_dir>. If you do not specify these directories, then the installation script will create them in the
current directory with default names.

4. You will be given a choice of pipelines to install. Please specify the numbers for the pipelines you require,
separated by a space, or type “A” for all pipelines.

5. To start Reflex, issue the command:

<install_dir>/bin/reflex

It may also be desirable to set up an alias command for starting the Reflex software, using the shell com-
mand alias. Alternatively, the PATH variable can be updated to contain the <install_dir>/bin
directory.
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3 Demo Data

Together with the pipeline you will also recieve a demo data set, that allows you to run the Reflex KMOS
workflow without any changes in parameters. This way you have a data set to experiment with before you start
to work on your own data.

Note that you will need a minimum of ∼5 GB, ∼9 GB and ∼2.5 GB of free disk space for the directories
<download_dir>, <install_dir> and <data_dir>, respectively.

The raw input consists of a single SCIENCE OB of the HII, star-formation region Gum 43 (RCW 65) executed
in NOD to SKY mode, and includes the raw calibration frames: darks, lamp flats, arc lamps, and flux standards.
The static calibration files (arc line lists, atmosphere model, OH spectral lines, and arc reference lines) are
included in the pipeline distribution. The raw tutorial data set is summarized in table 3.1.

Table 3.1: The KMOS Reflex workflow tutorial data set

File DPR.CATG DPR.TYPE INS.GRAT1.ID DET.SEQ1.DIT
KMOS.2013-06-27T02:30:02.036.fits CALIB FLAT,OFF K 3.0000000
KMOS.2013-06-27T02:30:13.935.fits CALIB FLAT,OFF K 3.0000000
KMOS.2013-06-27T02:30:26.009.fits CALIB FLAT,OFF K 3.0000000
KMOS.2013-06-27T02:33:25.442.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:33:37.272.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:33:49.244.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:34:42.585.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:34:54.500.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:35:06.539.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:35:59.909.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:36:11.744.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:36:23.588.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:37:17.002.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:37:27.878.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:37:40.018.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:38:33.399.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:38:45.321.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:38:57.219.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:39:50.556.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:40:02.535.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:40:14.442.fits CALIB FLAT,LAMP K 3.0000000
KMOS.2013-06-27T02:42:34.927.fits CALIB WAVE,OFF K 4.0000000
KMOS.2013-06-27T02:45:31.613.fits CALIB WAVE,LAMP K 4.0000000
KMOS.2013-06-27T02:46:24.832.fits CALIB WAVE,LAMP K 4.0000000
KMOS.2013-06-27T02:47:18.086.fits CALIB WAVE,LAMP K 4.0000000
KMOS.2013-06-27T02:48:12.603.fits CALIB WAVE,LAMP K 4.0000000
KMOS.2013-06-27T02:49:06.959.fits CALIB WAVE,LAMP K 4.0000000
KMOS.2013-06-27T02:50:01.906.fits CALIB WAVE,LAMP K 4.0000000
KMOS.2013-06-28T22:21:22.894.fits CALIB FLAT,SKY K 5.0000000
KMOS.2013-06-28T22:21:57.131.fits CALIB FLAT,SKY K 30.0000000
KMOS.2013-06-28T22:22:36.403.fits CALIB FLAT,SKY K 30.0000000
KMOS.2013-06-28T22:23:14.587.fits CALIB FLAT,SKY K 30.0000000
KMOS.2013-06-29T05:25:36.594.fits CALIB OBJECT,SKY,STD,FLUX K 10.0000000
KMOS.2013-06-29T05:26:08.050.fits CALIB OBJECT,SKY,STD,FLUX K 10.0000000
KMOS.2013-06-29T05:26:34.039.fits CALIB OBJECT,SKY,STD,FLUX K 10.0000000
KMOS.2013-06-30T14:52:42.168.fits CALIB DARK YJ 100.0000000
KMOS.2013-06-30T14:54:30.888.fits CALIB DARK YJ 100.0000000
KMOS.2013-06-30T14:56:19.580.fits CALIB DARK YJ 100.0000000
KMOS.2013-06-30T14:58:08.242.fits CALIB DARK YJ 100.0000000
KMOS.2013-06-30T14:59:56.907.fits CALIB DARK YJ 100.0000000
KMOS.2013-06-30T23:48:06.049.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-06-30T23:53:23.571.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-06-30T23:59:09.586.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:04:22.390.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:09:35.560.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:14:52.379.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:20:10.285.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:25:24.507.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:30:37.274.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:35:55.867.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:41:13.785.fits SCIENCE OBJECT,SKY K 300.0000000
KMOS.2013-07-01T00:46:26.588.fits SCIENCE OBJECT,SKY K 300.0000000
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4 Quick Start: Reducing The Demo Data

For the user who is keen on starting reductions without being distracted by detailed documentation, we describe
the steps to be performed to reduce the science data provided in the KMOS demo data set supplied with the
Reflex 2.4 release. By following these steps, the user should have enough information to attempt a reduction
of his/her own data without any further reading:

Figure 4.0.1: The empty Reflex canvas.

1. Start the Reflex application:

reflex &

The empty Reflex canvas as shown in Figure 4.0.1 will appear.

2. Now open the KMOS workflow by clicking on File -> Open File, selecting the file Kmos.xml
in the file browser. You will be presented with the workflow canvas shown in Figure 4.0.2. Note that the
workflow will appear as a canvas in a new window.

3. To aid in the visual tracking of the reduction cascade, it is advisable to use component (or actor) highlight-
ing. Click on Tools -> Animate at Runtime, enter the number of milliseconds representing the
animation interval (100 ms is recommended), and click OK .

4. Under “Setup Directories” in the workflow canvas there are seven parameters that specify important direc-
tories (green dots). Setting the value of ROOT_DATA_DIR is the only necessary modification if you want
to process data other than the demo data6, since the value of this parameter specifies the working direc-
tory within which the other directories are organised. Double-click on the parameter ROOT_DATA_DIR
and a pop-up window will appear allowing you to modify the directory string, which you may either edit
directly, or use the Browse button to select the directory from a file browser. When you have finished,
click OK to save your changes.

6If you used the install script install_reflex, then the value of the parameter ROOT_DATA_DIR will already be set correctly
to the directory where the demo data was downloaded.
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Figure 4.0.2: KMOS workflow general layout.

5. Click the button to start the workflow

6. The workflow will highlight the Data Organiser actor which recursively scans the raw data directory
(specified by the parameter RAWDATA_DIR under “Setup Directories” in the workflow canvas) and con-
structs the DataSets. Note that the calibration and reference data must be present either in RAWDATA_DIR
or in CALIB_DATA_DIR, otherwise DataSets may be incomplete and cannot be processed.

7. The Data Set Chooser actor will be highlighted next and will display a “Select Datasets” win-
dow (see Figure 4.0.3) that lists the DataSets along with the values of a selection of useful header key-
words7 namely the object name, OB execution number (OBS.ID), data category (DPR.CATG), data type
(DPR.TYPE), and the filter and grism used (INS.FILT1.ID and INS.GRAT1.ID). The first column con-
sists of a set of tick boxes which allow the user to select the DataSets to be processed, and by default all
DataSets are selected.

8. Click the Continue button and watch the progress of the workflow by following the red highlighting
of the actors. A window will show which DataSet is currently being processed.

7The keywords listed can be changed by right-clicking on the DataOrganiser Actor, selecting Configure Actor, and then
changing the list of keywords in the second line of the pop-up window. Make sure that the Lazy Mode is not active and then click on
Commit to save the change.
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Figure 4.0.3: The “Select Datasets” pop-up window.

The final products of the reduction pipeline can be found in the directory END_PRODUCT_DIR that is defined
in the “Setup Directories” section at the top of the workflow. The KMOS reconstructed science cubes can best
be viewed using the CASA viewer tool. The tool can be downloaded from http://www.eso.org/sci/
software/pipelines/ (see the entry “CASA 3D Viewer”). Loading the science data product labelled
SCI-GUM43_SCI_COMBINED.fits should show a strong source through the data cube.

Intermediate pipeline products can be found in subdirectories of the TMP_PRODUCT_DIR.

Well done! You have successfully completed the quick start section and you should be able to use this knowledge
to reduce your own data.

http://www.eso.org/sci/software/pipelines/
http://www.eso.org/sci/software/pipelines/
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5 Reducing Science Verification Data

To reduce science verification data, simply change the path to the raw data directory defined at the top of
the workflow labelled Setup Directories by double clicking on RAW_DATA_DIR. Then just re-run the
workflow as for the tutorial demo data.



ESO Reflex KMOS Tutorial
Doc: VLT-MAN-ESO-19500-....
Issue: Issue 0.5
Date: Date 2013-06-25
Page: 14 of 22

6 Optimising Your Results Through Workflow Interaction

In this section, we use the information from section 4 along with the KMOS demo data supplied with Reflex2.4
to illustrate how to optimise the scientific products in terms of quality and S/N. This is work in progress and
the contents of this section will grow as we gain experience and add functionality. Optimising the results is
achieved by interaction with the workflow actors via interactive windows displayed at key data reduction points
in the data flow, which enable iteration of certain recipes in order to obtain better results.

We recommend that the user has already carried out the reductions for all demo DataSets as described in Sec-
tion 4, although this is not a pre-requisite to following this section. By doing this, the user will be taking
advantage of the workflow Lazy Mode, with minimal waiting time between various pipeline recipe executions.

Please follow these steps in order to optimise the reductions for the KMOS demo data:

1. Carry out the first four steps described in the Quick Start Section 4.

2. In the KMOS workflow, the one interactive actor Wavelength Calibration (WAVE_CAL) is
identifiable by an orange rectangle encompassing the actor name. The interactive mode is enabled by
default. Should you wish to change that use Open Actor to get access to the the components of the
interactive actors, then double-click on the composite actors, setting the “EnableInteractivity” parameter
to false, and clicking Commit to save the changes to the workflow.

3. Wavelength Calibration: Figure 6.0.4 shows interactive window that will pop-up at the end of
the execution of the kmo_wave_cal pipeline routine. The image panels at the top of the window show the
reconstructed arc frames for each of the three detectors, at each of the six rotator angles (0, 60, 120, 180,
240, and 300 degrees). For each of these 18 frames, the relative average offset of the reconstructed arc
lines are plotted in units of km/s for each of the Argon and Neon arc lines (bottom two plots).

On the right-hand edge of the interactive window the user may modify a number of parameters to improve
the wavelength calibration. The parameters and their description is given in table 6.1. If parameters
have been changed, then clicking on the Re-run Recipe will re-exectute the kmo_wave_cal pipeline
routine.

Table 6.1: Parameters that a user can manipulate within the WAVE_CAL interactive window
Parameter1 Value (default) Explanation
–order 0 The polynomial order to use for the fit of the wavelength solution.

The appropriate order is chosen automatically depending on the waveband.

Otherwise an order of 6 is recommended, except for IZ-band, there order 4 should be used

–dev_flip FALSE Set this parameter to TRUE if the wavelengths are ascending on the detector from top to bottom

–dev_disp -1 The expected dispersion of the wavelength in microns/pixel.

If the default is not changed it will automatically be selected upon header keywords

–suppress_extension FALSE Suppress arbitrary filename extension. (if TRUE (apply) or FALSE (do not apply)

–b_samples 2048 The number of samples in wavelength for the reconstructed cube

–b_start -1 The lowest wavelength [µm] to take into account when reconstructing

(default of -1 sets the proper value for the actual band automatically)

–b_end -1 The highest wavelength [µm] to take into account when reconstructing

(default of -1 sets the proper value for the actual band automatically)
1 All parameters, available to the kmo_wave_cal pipeline routine, have been included for use in the WAVE_CAL interactive window.
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Figure 6.0.4: The interactive window for the Wavelength Calibration actor for the KMOS tutorial data
set..

4. In Development: In future iterations of the KMOS Reflex workflow we will include interactive
actors for the optimisation of the standard star and the science processing routines. Furthermore, a window
will be designed that allows the user to view the status of each KMOS IFU (i.e. active, not in PAF, locked,
etc.) and to select for which IFU data products should be displayed.

5. The panel of buttons at the top-left of the interactive window may be used to manipulate the displayed
plots. The buttons have the following functions:

• - Reset all the plot ranges to their original values.

• - Undo the last modification of the plot ranges (if possible).

• - Redo the next modification of the plot ranges (if possible).

• - Selecting this button allows the user to use the mouse to shift the plot ranges by left-clicking
on the target plot canvas and then dragging the mouse around while keeping the left mouse button
held down, and releasing when ready.
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• - Selecting this button allows the user to zoom in on each plot by left-clicking on the target plot
canvas to mark the top-left corner of a rectangle and then dragging the mouse to the bottom-right
corner of the rectangle and releasing. The plot ranges will then be modified to match the rectangle
that was defined. The following constraints can be made by holding simultaneously a key while
pressing the left mouse button:

Constrain pan/zoom to x axis hold X
Constrain pan/zoom to y axis hold Y
Preserve aspect ratio hold Ctrl

• - Clicking this button opens a “Configure subplots” window that allows the user to adjust the
spacing and positioning of the individual plots.

• - Clicking this button opens a “Save to file” window which allows the user to save a screenshot
of the current interactive window.

• - Clicking this button allows the user to change the display levels of the 2-dimensional merged
image by clicking on pixels within the 2-dimensional image (similar to ds9).

Use these buttons to inspect the plots in the interactive window in more detail.

6. Once the user is satisfied with the results, then clicking on the Continue Wkf button will continue
with the rest of the workflow.

7. As noted in the Quick Start Section 4, the workflow will then proceed through its remaining process-
ing steps and write out all pipeline products to the end products directory (specified by the parameter
END_PRODUCTS_DIR under “Setup Directories” in the workflow canvas). The science data products
from the tutorial data set are summarized in section 7 in table 7.2. The intermediate pipeline calibration
products can be found in subdirectories of the TMP_PRODUCT_DIR and are summarized in section 7 and
in table 7.1.
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7 KMOS Reduced Data Description

A number of intermediate pipeline products from the tutorial data set can be found in subdirectories of the
TMP_PRODUCT_DIR. These master calibration files are summarized in table 7.1.

Table 7.1: The KMOS Reflex workflow tutorial data set: calibration products

File PRO.CATG Description
kmos_dark:
badpixel_dark.fits BADPIXEL_DARK preliminary bad pixel map (hot pixels)
master_dark.fits MASTER_DARK master dark frame including a noise map

kmos_flat:
badpixel_flat_KKK.fits BADPIXEL_FLAT master bad pixel map (hot + cold pixels)
flat_edge_KKK.fits FLAT_EDGE fits table defining the edges of each IFU pseudo slit as derived from the screen flat frames
master_flat_KKK.fits MASTER_FLAT master flat-field frame including noise map
xcal_YJYJYJ.fits XCAL spatial solution lookup frame
ycal_YJYJYJ.fits YCAL spatial solution lookup frame

kmos_wave:
det_img_wave_KKK.fits DET_IMG_WAVE resampled image of reconstructed arc frame
lcal_KKK.fits LCAL wavelength solution lookup frame

kmos_illum:
illum_corr_KKK.fits ILLUM_CORR illumination correction to flat-filed
skyflat_edge_KKK.fits SKYFLAT_EDGE fits table defining the edges of each pseudo slit IFU as derived from the sky flat frames

kmos_std:
star_spec_KKK.fits STAR_SPEC extracted star spectrum
std_image_KKK.fits STD_IMAGE collapsed standard star cube image
std_mask_KKK.fits STD_MASK masked pixels within the collapsed standard star cube image
telluric_KKK.fits TELLURIC normalized telluric spectrum including noise map

The final products of the reduction pipeline can be found in the directory END_PRODUCT_DIR that is defined
in the “Setup Directories” section at the top of the workflow.

The science data products from the tutorial data set are summarized in table 7.2.
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Table 7.2: The KMOS Reflex workflow science products from the tutorial data set (all K-band)

File PRO.CATG Description
SCI-GUM43_MAKE_IMAGE.fits MAKE_IMAGE the median collapse of the IFU #1 data cube along the wavelength direction.
SCI-GUM43_MAKE_IMAGE_1.fits MAKE_IMAGE the median collapse of the IFU #2 data cube along the wavelength direction.
SCI-GUM43_MAKE_IMAGE_2.fits MAKE_IMAGE the median collapse of the IFU #3 data cube along the wavelength direction.
SCI-GUM43_MAKE_IMAGE_3.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_4.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_5.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_6.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_7.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_8.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_9.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_10.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_11.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_12.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_13.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_14.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_15.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_16.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_17.fits MAKE_IMAGE "
SCI-GUM43_MAKE_IMAGE_18.fits MAKE_IMAGE ". Only 19 IFU’s were active in this OB.

SCI-GUM43_SCI_COMBINED.fits SCI_COMBINED reconstructed science cube (coadded dithers) including noise map created from IFU #1.
SCI-GUM43_SCI_COMBINED_1.fits SCI_COMBINED reconstructed science cube (coadded dithers) including noise map created from IFU #2.
SCI-GUM43_SCI_COMBINED_2.fits SCI_COMBINED reconstructed science cube (coadded dithers) including noise map created from IFU #3.
SCI-GUM43_SCI_COMBINED_3.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_4.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_5.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_6.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_7.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_8.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_9.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_10.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_11.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_12.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_13.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_14.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_15.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_16.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_17.fits SCI_COMBINED "
SCI-GUM43_SCI_COMBINED_18.fits SCI_COMBINED ". Only 19 IFU’s were active in this OB.

SCI-GUM43_SCI_RECONSTRUCTED.fits SCI_RECONSTRUCTED intermediate reconstructed and combined science cube including noise map for pointing #1.
SCI-GUM43_SCI_RECONSTRUCTED_1.fits SCI_RECONSTRUCTED intermediate reconstructed and combined science cube including noise map for pointing #2.
SCI-GUM43_SCI_RECONSTRUCTED_2.fits SCI_RECONSTRUCTED intermediate reconstructed and combined science cube including noise map for pointing #3.
SCI-GUM43_SCI_RECONSTRUCTED_3.fits SCI_RECONSTRUCTED "
SCI-GUM43_SCI_RECONSTRUCTED_4.fits SCI_RECONSTRUCTED "
SCI-GUM43_SCI_RECONSTRUCTED_5.fits SCI_RECONSTRUCTED "
SCI-GUM43_SCI_RECONSTRUCTED_6.fits SCI_RECONSTRUCTED "
SCI-GUM43_SCI_RECONSTRUCTED_7.fits SCI_RECONSTRUCTED "
SCI-GUM43_SCI_RECONSTRUCTED_8.fits SCI_RECONSTRUCTED "
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8 Frequently Asked Questions

1. Where are my intermediate pipeline products?

Intermediate pipeline products are stored in the directory <TMP_PRODUCTS_DIR> (defined on the
workflow canvas) and organised further in directories by pipeline recipe.

2. Can I use different sets of dark frames to calibrate my flat frames and science data?

Yes. In fact this is what is currently implemented in the workflow(s). The function of the SofSplitter
is to investigate the incoming SoFs, sort them by “purpose”, and create separate SoFs for each purpose.
The RecipeExecuter then processes each of the SoFs independently. Finally, the SofAccumulator
packs all the results into a single output SoF. It is this purpose that is used by the workflow to send the
correct set of bias frames to the recipes for flat frame combination and science frame reduction, which
may or may not be the same set of bias frames in each case.

3. Can I launch Reflex from the command line?

Yes, use the command:

reflex -runwf -nocache -nogui <workflow_path>/<workflow>.xml

Note that this mode is not fully supported, and the user should be aware of two points. Firstly, the
execution prompt is not returned after the workflow finishes, and therefore Reflex must be manually
killed. Secondly, all the interactive windows will still appear (if activated in the workflow), so it is not
suitable for batch processing.

4. How can I add new actors to an existing workflow?

You can drag and drop the actors in the menu on the left of the Reflex canvas. Under Eso-reflex ->
Workflow you may find all the actors relevant for pipeline workflows, with the exception of the recipe
executer. This actor must be manually instantiated using Tools -> Instantiate Component.
Fill in the “Class name” field with org.eso.RecipeExecuter and in the pop-up window choose
the required recipe from the pull-down menu. To connect the ports of the actor, click on the source port,
holding down the left mouse button, and release the mouse button over the destination port. Please consult
the Reflex User Manual (Forchì 2012) for more information.

5. How can I broadcast a result to different subsequent actors?

If the output port is a multi-port (filled in white), then you may have several relations from the port.
However, if the port is a single port (filled in black), then you may use the black diamond from the
toolbar. Make a relation from the output port to the diamond. Then make relations from the input ports to
the diamond. Please note that you cannot click to start a relation from the diamond itself. Please consult
the Reflex User Manual (Forchì 2012) for more information.
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9 Troubleshooting

Figure 9.0.5: TheDataOrganizer interactive window reports an error “:No DataSets have been created, check
the data set and the OCA rules.”.

1. I downloaded the data from the ESO archive, put them into a new directory, tried to run Reflex
on them, but

(a) it crashs
This may happen if one of the files was downloaded only partially (check for a file with the extension
fits.Z.part. You will have to download that file again in order to have an uncorrrupted file (and
remove the partial one).

(b) it fails with error message “:No DataSets have been created, check the data set and the OCA
rules.”(see Figure 9.0.5.)
This error may be due to the fact that the data provided by the ESO archive are compressed
(<filename>.fits.Z). Please remember to uncompress the data before executing Reflex.

(c) all DataSets are greyed out in the DataSets interactive window.
The ESO archive used with CalSelector does not always supply all static calibration files. As a
consequence some/all DataSets are greyed out because they were missing such required data.
Missing static calibration should be found by reflex in
<install_directory>/calib/<pipeline_version>/cal.

2. The “Select DataSets” window displays my DataSets, but some/all of them are greyed out. What is
going on?

If a DataSet in the “Select DataSets” window is greyed out, then it means that the DataSet that was con-
structed is missing some key calibration(s) (i.e. the DataSet is incomplete). To find out what calibration(s)
are missing from a greyed out DataSet, click on the DataSet in question to highlight it in blue, and then
click on the button Inspect Highlighted . The “Select Frames” window that appears will report
the category of the calibration products that are missing (e.g. MASTER_BIAS). From this the user has
then to determine the missing raw data (in this case bias frames). If static calibrations are missing the
mechanism unfortunately does not work, but should be found by reflex in
<install_directory>/calib/<pipeline_version>/cal
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